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Configuration Manual

Robert Alex Pereira
Student 1D:22192328

1 Introduction

This is configuration module is submitted along with research paper as part of MSC fintech
Practicum module. This manual describes the detail steps followed for the research topic
“Comparative Study of Online Payment versus Offline (Traditional) Payment with Emphasis
on UPI in India and Changing Payment Regulations’. This manual walks through the step-by-
step technical analysis process of this research. It includes the hardware, software and specific
techniques implemented. This manual aims that the results of this research can be verified and
be reproduced for the study purpose.

2 Specification of the System

2.1 Hardware specification

Operating System Windows 11 Home Single Language

System Type 64-bit operating system, x64-based processor
Processor 12th Gen Intel(R) Core(TM) i5-1235U 1.30 GHz
RAM 16 GB

Storage Windows SSD 474GB

2.2 Software and tools

Operating System | Windows 11 Home Single Language

For access to Google products like Google Form and Google Sheet; used to
Gmail Account distribute the survey link to valid respondents.

Google Drive Required for the storage of files and data responses.

Primary tool for survey building in questionnaire format and tracking survey
Google Form progress.

Microsoft Excel MicrosoftA® Office 21 (64-bit)

IBM SPSS
Statistics IBM SPSS Statistics 29.0.2.0 for data analysis and result generation.

3 Installation and working of Software

3.1 IBM SPSS Statistics 29.0.2.0

In this project along with Excel IBM SPSS statistic module is used for the detail analysis of
the survey data.

This module is available for download on linke below and the process in fig.1 and 2
https://myibm.ibm.com/products-services/manage/512201808/downloads




2 @ O A MM X - o x
« C myibmibm.com/dacl ¢ o e« -~ 0
&
My 1BM fil Bill
My products
Sort by product name v
Trials
fer o/ IBM SPSS Modeler Trial 6 IBM SPSS Statistics
T Upgrade opt Subscription Trial
Expires on Aug 22, 2024 Expires on Sep 3, 2024 X Close
Active Active
Hil I'm a virtual assistant.
Download Manage Download Manage How can I help you
today?
Subscriptions ﬂ
= oy _ 2321
2 M Qsed hb'ﬁ_é-eu.ﬁﬂeﬂ "e(l’:fea')moazm:"-!

Fig 1 My IBM login and download option

MyIBM  Profile  Billing

IBM SPSS Statistics Subscription Trial for Microsoft Windows 64-bit

After the file has downloaded, use Windows Explorer to browse to the saved .exe file location. Right-

click on the saved .exe file and select Run as Administrator.

Download for Windows 64-bit R

IBM SPSS Statistics Subscription Trial for Mac 0S

Download for macOS ¥

Related Downloads
Drivers and access packs for connecting to databases and related software
IBM SPSS Statistics Data File Drivers 29.0 for Microsoft Windows 64-bit

IBM SPSS Data Access Pack 8.1.1 for Microsoft Windows 64-bit

Fig 2 IBM SPSS statistic module download as per system configuration 64-bit
After installation of the IBM SPSS the data is imported from excel and anaysis done. The
process of the anaysis is mentioned below in specific order. The output file is shared along

with dataset with this reserch paper.

All the outputs are been verified and performed using SPSS.

4 Data Source
In this steps of process the various data source links and analysis techniques are specified.
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4.1 Secondary data

4.1.1 data source

e RBI transactional data link.
https://rbidocs.rbi.org.in/rdocs/content/docs/PSDDP04062020.xlsx and
rbidocs.rbi.org.in

o NPCI Open Data : Monthly Metrics (npci.org.in) And RETAIL-PAYMENTS-
STATISTICS-202301 (1) (npci.org.in)

4.1.2 Data cleaning and analysis in excel:

For the analysis of the growth and trends of the UPI over other payment methods data is
collected from the above sources and imported in Excel. This data is cleaned for missing
values where ther were no transactions. Using the Pivot table data is summarized and
categorized under Online and offline payment.

4.2 Primary Data

4.2.1 Primary data Source

This study is made both on primary and secondary data. To collect the primary data the
Google form is used, the detail survey is been conducted. this form was distributed on social
media and emails. Responses received from this survey are been stored in google drive. The
dataset and the google form are been submitted along with the research paper in artefact.

https://docs.google.com/forms/d/e/1FAIpQLSfHMPnUISgRNMMtHjk m9xMwwZeX5M60o
EpfWVa7kuN220RprA/viewform?usp=sf link

Questions  Responses ()  Settings

Section 1 of 10

Comparative Study of Online Payment
versus Offline (Traditional) Payment with
Emphasis on UPI in India and Changing
Payment Regulations

My name is Robert Pereira, and | am part of the Master of Fintech programme at the National College of
Ireland. | am currently working on my dissertation, which aims to gather valuable insights into consumer
preferences between online and offline payments and the impact of changing payment regulations (UPI) in
India and the impact of evolving payment regulations.

3¢

1 am reaching out to request your support with the following survey that aims to evaluate some key points in
my research. Your participation is entirely voluntary, and all will remain and

All information collected will be used solely for academic purposes. The collected data will be held and
processed in accordance with GDPR (General Data Protection Regulation) and DPDPA (Digital Personal Data
Protection Act)

The survey consists of closed-ended questions and will not take long to complete. Your valuable contribution
is essential to the success of this research, and | am extremely grateful for your participation.

Thank you so much for your attention and consideration. Your participation will make a significant difference.

Best regards,
Robert Pereira

Consent

| understand my participation in this survey is entirely voluntary. | acknowledge that my
responses will be used for research purposes only and will remain confidential. | consent to
participate in this study and understand that | can withdraw at any time without any penalty.
By clicking “yes, | agree" below, | confirm that | agree to participate in the survey.

Yes | agree

No, I do not agree




4.2.2 Data cleaning for analysis

Survey data was saved in google sheet linked to the survey, this data is been downloaded into
the excel sheet and saved for the further analysis. The Excel dataset is been submitted along
with this paper.

4.2.3 data import in IBM SPSS

The data without missing values as the data questions were marked compulsory to avoid the
missing values. Excel data is been imported to IBM SPSS. Fig 3A and 3B

£ Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor
ile Edit View Data Transform Analyze Graphs Utilities Extensions Window Help
£ o =1 . B
] 14 @
Open L
Import Data > Database >
var var
General Open Excel...
(£ Open Restore Point. . CSV Data
¥y l ¢ Text Data...
H trl+ SAS .
Stata
¥ Save All Data Cognos Business Intelligence
[t} t t Cognos TM1...
Export >
B
Make Variable Catalog

Fig 3 A Data import in SPSS

3 *SPSS data anaysis.sav [DataSet1] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

EBHE D e~ EhLIM A BE JOEE

Name Type Width  Decimals Label Values Missing | Columns Align Measure Role

1 Timestamp Date 1 0 None None 1 3= Right & Scale N Input
2 Consentlun... String 13 0 Consentl unde... None None 13 EE Lent & Nominal N Input
3 @1.Whatisy... String 66 0 1. Whatis your ... None None 50 B Let & Nominal N Input
4  @2Whatisy... String 79 0 2. Whatis your ... None None 50 B Lett &) Nominal N Input
5 @3 Whichof... String 61 0 3. Which ofthe ... None None 50 B Lent & Nominal N Input
6 PE1 Numeric 2 0 {1, Strongly Agree). None 12 3 Right d Ordinal N Input
7 PE2 Numeric 2 0 {1, Strongly Agree)... None 12 3 Right d Ordinal N Input
8 PE3 Numeric 2 0 {1, Strongly Agree). None 12 3 Right d Ordinal N Input
9 PE4 Numeric 2 0 {1, Strongly Agree).. None 12 3= Right 4l ordinal N Input
10 EE1 Numeric 2 0 {1, Strongly Agree}... None 12 3 Right d Ordinal N Input
11 EE2 Numeric 2 0 {1, Strongly Agree)... None 12 3 Right d Ordinal N Input
12 EE3 Numeric 2 0 {1, Strongly Agree)... None 12 3 Right 4l Ordinal N Input
13 8si Numeric 2 0 {1, Strongly Agree)... None 12 3 Right 4l Ordinal N Input
14 SI2 Numeric 2 0 {1, Strongly Agree)... None 12 3 Right d Ordinal N Input
15 s13 Numeric 2 0 {1, Strongly Agree)... None 12 3 Right ol Ordinal N Input
16 RN Numeric 2 0 {1, Strongly Agree). None 12 3 Right d Ordinal N Input
17 RI2 Numeric 2 0 {1, Strongly Agree). None 12 3 Right d Ordinal N Input
18 RI3 Numeric 2 0 {1, Strongly Agree)... None 12 3 Right 4l Ordinal N Input
19 FC1 Numeric 2 0 {1, Strongly Agree). None 12 3= Right d Ordinal N Input
20 FC2 Numeric 2 0 {1, Strongly Agree)... None 12 3 Right d Ordinal N Input
21 FC3 Numeric 2 0 {1, Strongly Agree). None 12 3= Right d Ordinal N Input
22 Cs1 Numeric 2 0 {1, Strongly Agree). None 12 3= Right d Ordinal N Input
23 Cs2 Numeric 2 0 {1, Strongly Agree)... None 12 3= Right d Ordinal N Input
24 cs3 Numeric 2 0 {1, Strongly Agree)... None 12 3= Right ol Ordinal ~ Input
25 FRD1 Numeric 2 0 {1, Strongly Agree). None 12 3= Right d Ordinal N Input
26 FRD2 Numeric 2 0 {1, Strongly Agree)... None 12 3= Right d Ordinal N Input
27 FRD3 Numeric 2 0 {1, Strongly Agree)... None 12 3= Right ol Ordinal N Input
28 BN Numeric 2 0 {1, Strongly Agree). None 12 3= Right d Ordinal N Input
20 an Numarie 2 n /1 QWannlv Anraal  Mana 1 3| Dinht ol Ardinat N inmint

Fig 3 B Data import in SPSS
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S Data Analysis techniques used for Evaluation

5.1 Excel

Excel is used for the Transactional data analysis downloaded from the secondary data sites.
The pivot table is exercised to group the data into the online and oftline , the SUM, Average,
VLOOKUP, Percentage functions were used to analysis the data and to draw insights added
into the research paper. The graphs were anaysied as in fig 4 and 5

ONLINE VS OFFLINE PAYMENTS

8/%za9:~:,151.17
11‘/?‘9'32,2 .50
OTTQ)JJ“Z’Q 76

1,707

X2,00,36F -00,612-84————%2-30,353-+8——=2;51,483:65—=248,948.38
2019-20 2020-21 2021-22 2022-23 2023-24
— =Total offline (A) = =Total Online (B)

Fig 4 Online vs offline*datasource NPCI

preference of Payments

%35,00,000.00
X30,00,000.00
X25,00,000.00

Total offline (A)
%20,00,000.00

Total Online (B)
%15,00,000.00

UPI
%10,00,000.00
CASH+CTS
X5,00,000.00
- —

2019-20 2020-21 2021-22 2022-23 2023-24

Fig 5 payment preference*datasource NPCI

The pie chart was generated based on the pivot data generated. The chart was generated both
by comparing the volume of the transactions and the mode of different transactions. Result
evaluated in research paper.

5.2 IBM SPSS
The inbuilt modules of the IBM SPSS were used for the below analysis.

5.2.1 Demographic Analysis

From analysis module in SPSS, descriptive Statistics > crosstabs Fig. were used for the
demographic analysis.



1@ Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs Utilities Extensions Window Help

H @ g > “  PowerAnalysis z %m 13 OE’ E

Meta Analysis
Reports &

. _ " Descriptive Statistics > [E Erequencies
Bayesian Statistics > [ Descriptives
Tables z

[#] Population Descriptives

Compare Means and Proportions > -
mpa Pe Percentiles

General Linear Model >
6 &, Explore
7 Generalized Linear Models >
: TURF Analysis
8 Mixed Models >
9 Comsicte , B8 Crosstabs...
10
— Regression > [ Ratio

Fig 6 crosstabs for descriptive anaysis

t& Crosstabs
4 o
Timestamp A 1. What is your age group.
Ja Consentl understand
ave:
ol PE2 Column(s)
E t
ol PE3 a 2. What is your highest le.
ol PE4 [ # ] &3 Which ofthe following .
4l EE1
d EE2 Layer 1 of 1
d EE3 Previous Next
4 s
4 si2
4 si3 -
4RI .
O
[[] Display clustered bar charts
[] Suppress tables
I Paste I Reset ] ICance\ Help I

Fig 7 selection of cross tab constraint
As per fig 7 for discriptive anaysis AGE was primary whereas Education and income was
considered secondary for the evaluation. This anaysis was condicted to evaluate which age
group is more active on UPI preference and how AGE and the education vs income differes
for the prefernce between online and offline.

5.2.2 Descriptive Statistics

Descriptive statistics like

mean, Standard deviation, Skewness, kurtosis was generated using Analyze> Descriptive
Statistics > Descriptives > selecting variables from PE1 to BI2> Ok Fig 8

This analysis was done to check the statistics reliability of the data.



@ *SPSS data anaysis.sav [DataSet1] - IBM SPSS Statistics Data Editor

File  Edit

Name
Timestamp

PE1
PE2
PE3
PE4
FF1

© 0O N, EWN -

-
=4

Consentlun...
@1.Whatisy...
@2 Whatisy...
@3.Whichof...

View Data

mHE 0 v~

Type
Date
String
String
String
String
Numeric
Numeric
Numeric
Numeric
Numeric

Transform  Analyze

Width

"

Graphs  Utilities  Extensions
Power Analysis >
Meta Analysis >
Reports >
Descriptive Statistics >

Bayesian Statistics
Tables

Compare Means and Proportions

General Linear Model
Generalized Linear Models
Mixed Models

Window Help

gy O ®

Missing | Columns

None 1"
[E] Erequencies. ..
Descriptives...
[+] Population Descriptives
Percentiles.
&, Explore...
TURF Analysis

s

Align
= Right

5.2.3 Frequency analysis

Fig 8 Descriptive Statistics

Frequency analysis was conducted to check the total number of responses and their

distribution in different components for the further analysis.

Analyza > Descriptive Statistics > Frequency > variable selection > Ok

+{E Title
@ Notes
- {8 Pe1
(§ PE1
&-{g PE2
(§ PE2
- PE3
PE3
&8 Pe4

A

Transform

Frequency 200

Frequency 185

# *Final Output.spv [Document1] - IBM SPSS Statistics Viewer
Gile  Edit  View Data

FHEQ NE e -

&8 Frequencies

Inset  Format  Analyze Graphs  Utilities
Power Analysis
Meta Analysis
% Frequencies
Reports
Descriptive Statistics

Bayesian Statistics
1 Tables
Compare Means and Proportions
General Linear Model
Generalized Linear Models
Mixed Models
Correlate

D

1

Extensions

>

Window Help

> l Q Search application
>

[ Erequencies...
Descriptives

4] Population Descriptives
[ Percentiles..

& Explore

TURF Analysis

{3 Crosstabs...

Ratio...

Fig 9 Frequency anaysis option

Individual frequency of each component is generated Fig 10, however to evaluate the result,
the data is combined in Excel and the table reported in research paper.




Froquoncy Table
PE1
Valid
Strongly
Strongly Agree Agree Neutral Disagree Disagree Total
Frequency 58 105 100 111 47 a1
PE2
Valid
Strongly
Strongly Agree Agree Neutral Disagree Disagree Total
Frequency 55 109 105 110 42 a1
PE3
Valid
Strongly
Strongly Agree Agree Neutral Disagree Disagree Total
Frequency 59 107 94 117 44 421
PE4
Valid
Strongly
Strongly Agree Agree Neutral Disagree Disagree Total
PE4 58 108 100 113 42 421

Fig 10 individual Frequency table.

5.2.4 Reliability Analysis using Cronbach's Alpha

To calculate the reliability of Cronbach Alpha Ananlyze > Scale > variable selection>
statistics> Item & Scale if item is deleted(checkbox) is selected Fig 11. This will give us
reliability score and table if item deleted. Fig 12



i *Final Output.spv [Document1] - IBM SPSS Statistics Viewer

W REBSUILY ATy HEUSIL. A

Gle Edt View Data Trnsrm jnsent Fomat Ansyze Graphs Utities Extensions Y oo™ s’
WHER A O e W ok e S
Mg Meta Analysis >
@ (] Reports > 5"“‘"":"" m“"‘
: : Descriptive Statistics > Dlysisnces 35,':,“..
: : mim Statistics : 8m S
: : Compare Means and Proportions > agork
3 eI
Generalized Linear Models > ol
Mixed Models > Missing
Correlate > © Exclude both user-missing and system missing values
Bogreesion ~ O User-missing values are treated as valid
[JHotelling's T-square (] Tukey's test of additity
Loglinear 2 [ intractass conelation coeficient
Neural Networks 2 Mogel [ - S
Classify > Conbidence intenval |95 3 est valye: [0
Dimension Reduction > B (oo ] o |
Mapping >
Scale > (A Reliability Analysis...
Nonparametric Tests > [ Weighted Kappa. .
Forscasting > B Mytidimensional Unfolding (PREFSCAL)..
:“;’:‘ . > B8 Multidimensional Scaling (PROXSCAL)... ‘
— ponse > B Muhidimensional Scaling (ALSCAL).. :
Fig 11 Cronbach’s reliabity selection
Item-Total Statistics
Corrected Squared Cronbach's
Scale Meanif  Scale Variance Iltem-Total Multiple Alpha if ltem
Item Deleted if tem Deleted Correlation Correlation Deleted
PE1 60.63 185.405 515 324 .824
PE2 60.52 184.398 545 372 .822
PE3 60.51 182.022 .604 424 .820
PE4 60.48 182.365 570 375 .821
EE1 60.47 183.464 563 .393 .822
EE2 60.17 194.148 .364 185 .830
EE3 60.34 197.568 .272 119 834
S 60.25 195.850 .339 .220 .831
SI2 60.27 194.454 .340 185 .831
SI3 60.30 196.368 .292 170 .833
RI1 60.27 196.148 .308 A7 .832
RI2 60.31 195.516 .327 189 .832
RI3 60.17 195.652 .308 .201 .833
FC1 60.22 194.574 .340 193 .831
FC2 60.29 196.661 .293 127 .833
FC3 60.28 195.746 324 145 .832
CS1 60.17 195.093 334 178 .831
CS2 60.25 194.327 .358 .200 .831
CS3 60.28 196.084 .307 175 .833
FRD1 60.20 194.547 341 .204 831
FRD2 60.29 195.845 318 162 .832
FRD3 60.23 194.666 .348 172 .831
BI1 60.28 195.210 343 181 .831
BI2 60.23 193.211 .385 .253 .830




Fig 12 Cronabach relaiability if item deleted.

5.3 Factor analysis

For this research factor analysis was primary analysis method is described in the research
paper. The analysis is conducted using SPSS inbuilt statistics module. Fig 13 displays the
detail step by step analysis conducted.

§ *Final Outputspv [Documentl] - 1M SPSS Statistics Viewer Step 1 Step 2

#e Edt View Data Transfom Inset Format Analyze Graphs LUtities Extensions Window Help

= & ﬂ’i Factor Analysis X
BHSR A M v w roeione I [@ [ seme mcner
= Meta Analysis >
- Rusns . na .
b4 E F“"";“mi Descriptive Statistics > &2 Timestamp ol PE1
& {J Reliadity Bayesian Statistics > Ja Consentl understa 4lPE2 A
e : ripoel
o SIS & (] e |
& Facor Anaisis L ’ a 3. Which of the follo A EE1 -
Generalized Linear Models >
Muged Models > d
Comelate > JHEE3 v
Rogression > Selection Vanable
Loginear >
Neural Networks >
Classify > Value
1 Dimension Reduction > Eactor
Mappng > @ Comespondence Analysis [ Paste l Reset 1 lCance\] [ Help ]
el > 3 Optimal Scaing
X ﬁ Factor Analysis: Descriptives 52 < 1@ Factor Analysis: Extraction >
Step 4
Step 3 Statistics Qes:lcnp(hes Method: Principal components p
Descriptives
[ Univariate descriptives A(;a":)’lel :3)' . »
xtraction iR : ofrelation matrix 4] Unrotated factor solution
= M Initial solution Rotation e o 2 fi !
| Correlation Matrix Options Extract
[] Coefficients [ Inverse © Based on Eigenvalue
= ["] Significance levels[ ] Reproduced Eigenvalues greater than [:l
O Fixed number of factors

[[] Determinant [] Anti-image
[ KMO and Bartlett's test of sphericity

Factors to extract

[ |Covariance matrix

3

It for C

b A

ﬁ Factor Analysis: Rotation X ti Factor Analysis: Options >
Method Missing Values
Step 5 Descriptives ) Descriptives 9 Step 6
O None O Quartimax - @® Exclude cases listwise
| e | traction
Extraction @ Varimax O Equamax N O Exclude cases pairwise
O Direct Oblimin O Promax Rotation O Replace with mean
Scores Scores
Options [4 Apply Kaiser normalization Options Coefficient Display Format
[[] Sorted by size
Display = 2 coelich
V] Suppress small coefficients
[M Rotated solution[_] Loading plot(s)
Absolute value below
M. Iterations for C gence
] 1 o [T

Fig 13 SPSS Factor anaysis process

5.3.1 KMO and Bartlett's test for sample adequacy and Homogeneity of variables.
e [BM SPSS> Analyze > Dimension Reduction > Factor.
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e In the Factor Analysis dialog box Fig 13 under the Descriptives option, select KMO
and Bartlett's test to assess sample adequacy and homogeneity of variables. Click
OK this will generate the table with detail results.

5.3.2 Communalities

e After running the Factor Analysis, in the output window, locate the Communalities
table, which shows the shared variance of each variable with all other variables. Fig
14

o Ensure that the extraction values are reasonably high (above 0.4) to confirm that the
variables are well-represented by the factors.

Communalities

Initial Extraction
PE1 1.000 .969
PE2 1.000 .966
PE3 1.000 .966
PE4 1.000 970
EE1 1.000 971
EE2 1.000 972
EE3 1.000 970
s 1.000 972
SI2 1.000 972
SI3 1.000 973
RI 1.000 974
RI2 1.000 972
RI3 1.000 97
FC1 1.000 977
FC2 1.000 .980
FC3 1.000 978
CS1 1.000 .968
CS2 1.000 .970
CS3 1.000 .969
FRD1 1.000 970
FRD2 1.000 965
FRD3 1.000 .970
Bl 1.000 976
BI2 1.000 977
Extraction Method: Principal
Component Analysis.

Fig 15 communalities

5.3.3 Total Variance Explained

e In Extraction tab Select Eigenvalues greater than 1 under the method for factor
extraction.

e The Total Variance Explained table will appear in the output, showing the
eigenvalues and the percentage of variance explained by each factor. Fig 16
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Total Variance Explained

Initial Eigenvalues Extraction Sums of Squared Loadings Rotation Sums of Squared Loadings
Component Total % of Variance  Cumulative % Total % of Variance Cumulative % Total % of Variance  Cumulative %
1 4.046 16.858 16.858 4.046 16.858 16.858 3.874 16.141 16.141
2 3.357 13.986 30.844 3.357 13.986 30.844 2.935 12.230 28.371
3 3111 12.963 43.807 3111 12.963 43.807 2.919 12.162 40.532
4 2.936 12.234 56.042 2.936 12.234 56.042 2.916 12.151 52.684
5 2.865 11.937 67.979 2.865 11.937 67.979 2.913 12.136 64.819
6 2.683 11.179 79.158 2.683 11.179 79.158 2.907 12.111 76.930
7 2.472 10.298 89.456 2.472 10.298 89.456 2.904 12.100 89.031
8 1.850 7.708 97.164 1.850 7.708 97.164 1.952 8.134 97.164
9 .063 .260 97.425
10 .056 234 97.659
1 .055 228 97.887
12 .052 215 98.102
13 .046 192 98.294
14 .046 191 98.485
15 .044 185 98.669
16 .043 181 98.851
17 .040 168 99.019
18 .040 167 99.185
19 .037 155 99.340
2 .035 146 99.486
21 .034 41 99.627
22 .032 135 99.762
23 .031 128 99.889
24 .027 A11 100.000

Extraction Method: Principal Component Analysis.

5.3.4

5.3.5

Fig 16 Total Variance explained

Scree Plot

Factor Analysis > Extraction > check the Scree plot option under the Display
section.

The Scree Plot will appear in the output along with all the details, which has helped in
determining the number of factors to retain by identifying the point where the plot
levels off.

Rotated Component Matrix

Factor Analysis > Rotation section, and select a rotation method Varimax to
achieve a clearer factor structure.

The Rotated Component Matrix will appear in the output, showing the loadings of
each variable on the rotated factors, helping in the interpretation of the factors. Fig 17
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Component 1 2 3 4 5 6 7 8
PE1 .983
PE2 .980
PE3 982
PE4 .983
EE1 .985
EE2 .985
EE3 .985
SI1 985
SI2 .983
SI3 .984
RI1 .986
RI2 .985
RI3 985
EC1 .986
FC2 .989
FC3 .986
CS1 .982
CS2 .983
CS3 .983
FRD1 981
FRD2 978
FRD3 978
BI1 .985
BI2 .986
Extraction Method: Principal Component Analysis.

Rotation Method: Varimax with Kaiser Normalization.?

a Ratation canveroed in S iteratione

Fig 17 Rotation componant matrix

5.3.6 Average Variance Extracted (AVE) and Composite Reliability (CR)
Example

Select Factor Loadings from Rotation Component Matrix grouped s in Fig 17, For
Component 1, the loadings are:

e PE1:0.983
e PE2:0.980
o PE3:0.982
o PE4:0.983

Step 1: Calculate the AVE (Average Variance Extracted)
The AVE is calculated using the formula:

3 (Factor Loading?)

= Number of Items

e Square the loadings:
 PE1:0.9837 = 0.966289
o PE2:0.980% = 0.960400
o PE3:0.982% — 0.964324
o PE4:0.983% = 0.966289
e Sum of squared loadings:
o 0.966289 + 0.960400 + 0.964324 + 0.966289 — 3.857302

e Number of items = 4

So, the AVE is:

_ 3.857302

AVE = 0.9643255 ~ 0.964

13



Step 2: Calculate the CR (Composite Reliability)
The CR is calculated using the formula:

(3= Factor Loadings)?
(3> Factor Loadings)2 + Y (1 — Factor Loadings®)

CR =

e Sum of loadings:
e 0.983 + 0.980 + 0.982 + 0.983 — 3.928
e Square of the sum of loadings:
e 3.928% = 15.428784
e Sum of 1 — Factor Loading? (error variance):
e 1—0.966289 — 0.033711
e 1—0.960400 = 0.039600
e 1—0.964324 — 0.035676
e 1—-0.966289 — 0.033711
e Sum of error variances:

e 0.033711 + 0.039600 + 0.035676 + 0.033711 = 0.142698

So, the CR is:

15.428784 15.428784

= 15.428784 + 0.142698  15.571482

= 0.9918

As per example the AVE and CR values are calculated using Excel function of SUM.

6 Conclusion

This Manuel is part of the research conducted and the result produced, this Manuel will assist
to replicate the results evaluated. This process flow will assist to enhance the technical
knowledge and give more understanding of the research paper. Further, future changes in the
version and the technological advancement may affect the validity of these results. These
results with all the specification mentioned will be replicated similarly.
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